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What is citations?

• A citation is a reference to a of information source 
used in academic research, and they serve as an 
"address" of sorts to those sources.

• Regardless of the format/style you're using (APA, 
MLA, Chicago Manual of Style (CMOS), IEEE, Harvard, 
CSE, or others), they usually take two forms within 
the same work:

• Reference or complete citations,

• In-text or parenthetical citations



When you need to 
reference?

• Any facts, claims, or ideas that are not 
your own and are not common 
knowledge must be referenced in your 
assignments.

• Even if you've re-written content into 
your own words, you still need to include 
references.

• Referencing allows your reader to check 
your sources if they find them 
interesting.



SAMPLE OF REFRENCES CITATION FOR ARTICLES



In-text or parenthetical citations



CITATION STYLES

There are (3) major citation styles 
used in academic writing:

i. Modern Language 
Association (MLA)

ii. American Psychological 
Association (APA)

iii. The Chicago Manual of Style,

which supports two styles:

• Notes and Bibliography

• Author-Date.



OTHER CITATION 
STYLES

• There are many other citation styles 
used in specific academic journals. For 
example: 

• IEEE Style

• Harvard Style

• CSE Style

• ASA Style

• Others 



APA (AMERICAN 
PSYCHOLOGICAL ASSOCIATION)

• Style is widely used in the social 
sciences, business, and some of 
the life sciences. 

• APA Style uses brief in-text 
citations in the text that refer to 
an alphabetical list 
of references appearing the end 
of the work.



OF APA REFERENCES

IN-TEXT CITATION REFERENCE LIST ENTRY

(Ibrahim, 2020) Ibrahim, A. S. (2020). A Concise Guide to the Quran : Answering Thirty Critical Questions.
Grand Rapids: Baker Academic.

Book

IN-TEXT CITATION REFERENCE LIST ENTRY

(J. A Goldschmidt, 2018) J. A Goldschmidt. (2018). The rise of Islam to Zenith of Arab power. In I. Al-
Marashi. (Ed.), A concise history of the middle east. Taylor & Francis 
Group.

Chapter in edited book 



IN-TEXT CITATION REFERENCE LIST ENTRY

(McAuliffe, 2020) McAuliffe, J. (2020). The Qur’an : What Everyone Needs to Know. Oxford: Oxford 
University Press, Incorporated. ProQuest Ebook Central

Journal article

IN-TEXT CITATION REFERENCE LIST ENTRY

(Rahman, 2012) or 
Rahman (2012)

Rahman, Y. (2012). The Qur’an as Literature: Literary Interpretation of the Qur’an. 
Journal of Qur’an and Hadith Studies, 1(1), 21–38.

OF APA REFERENCES

E-Book



IN-TEXT CITATION REFERENCE LIST ENTRY

(Abu-Ras & Laird, 2011) Abu-Ras, W., & Laird, L. (2011). How Muslim and Non-Muslim Chaplains Serve Muslim 
Patients? Does the Interfaith Chaplaincy Model have Room for Muslims’ 
Experiences? Journal of Religion and Health, 50(1), 46–61. 
https://doi.org/10.1007/s10943-010-9357-4

Online Journal

IN-TEXT CITATION REFERENCE LIST ENTRY

(Salleh, 2020) Salleh, S. M. S. B. S. M. (2020). Islamic View On The Role Of The Government. IKIM.  
http://www.ikim.gov.my/index.php/2020/03/10/islamic-view-on-the-role-of-the-
government/

Website

OF APA REFERENCES

http://www.ikim.gov.my/index.php/2020/03/10/islamic-view-on-the-role-of-the-


The 17th Chicago Manual of 
Style

• Released in late 2017

• Chicago-style source citations come in two 
varieties: 

i. Footnotes and bibliography 

ii. Author-date.

• Sources are cited in numbered footnotes or 
endnotes. 

• Each note corresponds to a raised 
(superscript) number in the text.

• The use of ibid. is now discouraged in favor of 
shortened citations.



FOOTNOTE REFERENCES

• Chicago uses a footnote style of referencing, 
which provides space for notes as well as 
citation information. 

• Footnotes are found at the bottom of the 
page

• The first line of a footnote is indented.

• A footnote contains the complete citation 
information



Shortened references for footnotes

• These are used for the second and further footnotes of a particular 
source, after you’ve already given the full citation once.

• Shortened footnotes contain the author’s family name, a shortened 
form of the title, and page number(s).

Because Akker’s article has
been cited before in
this writing (fn1), a
SHORTENED FORM of
citation is used, but
now with the new page
numbers specific to
where this information
came from



BIBLIOGRAPHY

• The bibliography should appear 
at the end of the work on a 
separate page. 

• Include all works cited in the 
text. You may also include any 
very relevant works that you 
have used and not cited. 

• References should be listed in 
alphabetical order by surname. 

• Include a hanging indent after 
the first line for each work.



FOOTNOTE REFERENCE
1 Ayman S. Ibrahim, A Concise Guide to the Quran : Answering Thirty Critical 
Questions. (Grand Rapids: Baker Academic, 2020), 123

BIBLIOGRAPHY

Ibrahim, Ayman S. A Concise Guide to the Quran : Answering Thirty Critical Questions.
Grand Rapids: Baker Academic, 2020.

OF CHICAGO REFERENCES

Book



FOOTNOTE REFERENCE
2 J. A Goldschmidt, “The Rise of Islam to Zenith of Arab Power,” in A Concise History of 
the Middle East., ed. Ibrahim Al-Marashi. (Taylor & Francis Group, 2018).

BIBLIOGRAPHY

Goldschmidt, J. A . “The Rise of Islam to Zenith of Arab Power.” In A Concise History of the 
Middle East., edited by Ibrahim Al-Marashi. Taylor & Francis Group, 2018.

OF CHICAGO REFERENCES

Chapter in edited Book



FOOTNOTE REFERENCE

3 Jane McAuliffe, The Qur’an : What Everyone Needs to Know (Oxford: Oxford University Press, Incorporated., 
2020), ProQuest Ebook Central.

BIBLIOGRAPHY

McAuliffe, Jane. The Qur’an : What Everyone Needs to Know. Oxford: Oxford University Press, Incorporated., 2020. 
ProQuest Ebook Central

Online Books 

OF CHICAGO REFERENCES



FOOTNOTE REFERENCE

3 Yusuf Rahman, “The Qur’an as Literature: Literary Interpretation of the Qur’an,” Journal of Qur’an and 
Hadith Studies 1, no. 1 (2012): 21–38.

BIBLIOGRAPHY

Rahman, Yusuf. “The Qur’an as Literature: Literary Interpretation of the Qur’an.” Journal of Qur’an and 
Hadith Studies 1, no. 1 (2012): 21–38.

Journal article

OF CHICAGO REFERENCES



FOOTNOTE REFERENCE

4 Wahiba Abu-Ras and Lance Laird, “How Muslim and Non-Muslim Chaplains Serve Muslim Patients? Does 
the Interfaith Chaplaincy Model Have Room for Muslims’ Experiences?,” Journal of Religion and Health 50, no. 1 
(2011): 46–61, https://doi.org/10.1007/s10943-010-9357-4.

BIBLIOGRAPHY

Abu-Ras, Wahiba, and Lance Laird. “How Muslim and Non-Muslim Chaplains Serve Muslim Patients? Does the 
Interfaith Chaplaincy Model Have Room for Muslims’ Experiences?” Journal of Religion and Health 50, 
no. 1 (2011): 46–61. https://doi.org/10.1007/s10943-010-9357-4.

Online Journal 

OF CHICAGO REFERENCES



FOOTNOTE REFERENCE

4 Shaikh Mohd Saifuddeen B Shaikh Mohd Salleh, “Islamic View On The Role Of The Government,” IKIM, 
2020, http://www.ikim.gov.my/index.php/2020/03/10/islamic-view-on-the-role-of-the-government/.

BIBLIOGRAPHY

Salleh, Shaikh Mohd Saifuddeen B Shaikh Mohd. “Islamic View On The Role Of The Government.” IKIM, 2020. 
http://www.ikim.gov.my/index.php/2020/03/10/islamic-view-on-the-role-of- the-government/.

Website

OF CHICAGO REFERENCES

http://www.ikim.gov.my/index.php/2020/03/10/islamic-view-on-the-role-of-the-government/
http://www.ikim.gov.my/index.php/2020/03/10/islamic-view-on-the-role-of-


The Chicago 
Manual of Style

ARABIC SOURCES



Superscript number in the 
text

Sources cited in numbered 

footnotes

The first line of the source 
must be indented.
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MENDELEY 
REFERENCE MANAGER



WHAT IS 
REFERENCE 
MANAGER 
(RM)?

• To build local libraries that they 
can organize, sort, and reference 
when writing. 

• Typically, be “plugged in” directly 
to the researcher’s word 
processing software or web 
browsers. 

• Automatically create 
bibliographies formatted to a 
journal or style manual’s specific 
requirements.



SAMPLE 
RM

1. Aigaion

2. Bebop

3. BibDesk

4. Bibus

5. Biblioscape

6. Bookends

7. Citavi

8. Connotea

9. CiteULike

10. Qiqqa

11. Mendeley

12. Papers

13. EndNote

14. JabRef

15. Reference



INTRODUCTION
• Mendeley Reference Manager is a free 

web and desktop reference 
management application. 

• Mendeley Reference Manager can:

• Store, organize and search all 
references in one library.

• Insert references and bibliographies 
into the Microsoft® Word documents 
using Mendeley Cite or MS Word 
Plugin

• Read, highlight and annotate PDFs

• Collaborate with others by sharing 
references and ideas.



MENDELEY INTERFACE

Add files 
menu

Folders 
menu

Sync Search

Discovery
My 

Library
Groups

Main 
panel

Details 
panel

Filter 
panel



MENDELEY INTERFACE
ITEM DESCRIPTIONS

Add files menu To add new entries to your Mendeley library

Folders menu To create a new folder to organize Mendeley library. Use the ‘Remove folder’ button to

remove the folder you are currently viewing.

Sync To force Mendeley to perform a sync. This will push any changes you’ve made to your

library up to the cloud for storage, making them available on other devices and computers.

You should sync frequently in order to ensure that your most recent changes are saved to the

cloud.

Search To search your Mendeley library. Note that Mendeley Desktop search function will also

return results within the text of PDF documents within your library, in addition to the

contents of the document’s details.

Discovery To discover new references in a number of different ways. Use ‘Literature Search’ to search

within Mendeley’s crowd-sourced catalogue. Alternatively, you can use ‘Mendeley

Discovery’ which is available at: https://www.mendeley.com/?interaction_required=true

https://www.mendeley.com/?interaction_required=true


MENDELEY INTERFACE

ITEM DESCRIPTIONS

My Library To view the entire contents of your personal library by selecting ‘All Documents’.

Groups Any groups you join or create will be listed under this heading. The icon that appears next to

the group’s name indicates the group type

Main panel When in browsing mode, the main panel of Mendeley Desktop will display the contents of the

selected view. You can use the column headings to quickly reorder the contents. Double click

an entry with a PDF attached (indicated by an icon) to open it in the PDF reader.

Details panel Contains the details of whichever library entry you currently have selected. This will show the

relevant detail fields for the document type, along with their contents. You can use this panel to

modify an entry’s details. The ‘Notes’ tab that appears at the top will allow you to view any

notes you’ve created for the entry.

Filter panel The filter panel offers several different options to allow you to quickly filter your current view



ORGANIZING THE DOCUMENT

• Displays the references that you’ve most recently added to your libraryRecently Added

• Displays a list of the PDF files you’ve recently opened for readingRecently Read
• At any time, you are able to ‘star’ a reference by clicking on the star that appears next to its 

entry in your Mendeley library. This will mark the item as a ‘Favorite’ and add it to the Favorites 
view

Favorites

• lists any items which Mendeley has imported, but may require extra attention. Once you review 
the details and indicate that they’re correct, it will be removed from this listNeeds Review

• This folder is used for adding your own personally authored publications to Mendeley.My Publications



CREATE FOLDER

Folders offer a way to quickly filter your

view of your library. Unlike folders on

your computer, adding a reference to a

folder in Mendeley does not relocate the

reference itself – but instead acts as a sort

of label for that reference. This means that

the same reference can be added to

multiple folders as required, and folders

can be deleted when no longer required

without any effect on the references

within.



ADDING YOUR DOCUMENT

Drag and drop 
files or folders

1

Add a specific 
file or folder

2

Manually create 
an entry

3

Auto-add 
documents with 
a Watch Folder

4



1. Drag and drop files 
or folders

Add papers to Mendeley by dragging
and dropping a PDF into the
Mendeley Desktop window.
Mendeley will automatically extract
the details from the document and
create a library entry. You can also
drag and drop a folder containing
multiple papers – Mendeley will
work its way through the contents,
creating library entries for the PDFs it
finds.



2. Add a specific file 
or folder

Use the File menu to ‘Add 
Files…’. Use this option to select 
a specific paper from a location 
on your computer and add it to 
your Mendeley library. 

Use ‘Add Folder…’ – also found 
in the File menu – to select a 
specific folder and to add any 
papers it contains to your library.



3. Manually create 
an entry

Use File > ‘Add Entry 
Manually…’ to manually 
input the details of a 
reference. Select the 
appropriate document type 
and complete the fields to 
create a library entry using 
the details you provide. This 
can be used to create library 
entries for items that you do 
not hold in PDF form – such 
as books, articles and other 
types of media.



4. Watch folder

A Watch Folder allows you to automatically 
add new documents to your Mendeley 
library. 

Simply drop PDFs into the folder and 
Mendeley will import them automatically 
for you.

Three type of Watch Folder

• Portable Storage

• Local Drive

• Cloud Storage  : Dropbox



To set up a Watch Folder

• Select the 'Watch Folder' option from the add files 
dropdown menu on the main toolbar and browse to 
the folder containing the documents you're interested 
in.

• Mendeley will add each document to your library, 
scanning each one for useful details such as title, 
author and journal.

• Any subsequent documents added to the folder will 
automatically be added to Mendeley.



IMPORT CONTENT INTO MENDELEY

WEB IMPORTER LITERATURE 
SEARCH



WEB IMPORTER

• Save references from the web
directly to your Mendeley
library with the Mendeley Web
Importer.

• This browser extension scans
your current browser window
for references and retrieves full
text PDFs wherever possible.

• We can use web importer in:
Google Scholar, Amazon, JSTOR,
EBSCOhost, SAGE, Springer Link



Literature Search

Search technique Example

Boolean Search AND, OR, NOT teaching AND technology

Search for selected year teaching AND technology year:[2015 TO 2020]
Teaching AND technology year:2013 

Search in selected journal Teaching AND technology year:2013 AND published_in:"education"

Search in open access journal Teaching AND technology year:2013 AND oa_journal:yes

If the author is known Teaching AND technology AND author:Mary AND published_in:education

Using exact phrase "teaching arabic" AND oa_journal:yes AND year:[2010 TO 2018]
"teaching arabic" AND oa_journal:yes AND year:[2010 TO 2018] AND 
author:Muhammad



How to add your Literature 
Search result?

• 1. Drag and Drop

• 2. Tick on the dot



How to back up your 
data?

• Create folder for backup (local 
or cloud storage)

• In Mendeley Desktop, click Tool 
– Option – File Organizer

• Tick Organize my files and then 
click browse

• Select your folder for backup

• Click Apply



Complete your 
metadata

Check all metadata is 
correct and complete to 
make sure your citation 
& references 
information  is complete 
and correct



TAGS AND FILTERING

• Tags allow you to apply quick text labels to
references in order to easily group them. Add
tags (separated using semi colons) to the field
found in the document details panel.

• Retrieve tagged items using the Filter menu
that appears in the bottom left corner of
Mendeley Desktop. Choose ‘Filter by My
Tags’ from the dropdown menu, and select
the desired tag. The filter menu is context-
specific.

• Only tags used within the current view will
be available to select. Make sure ‘All
Documents’ is selected in order to select
from the full list of tags.



Add Note, Copy, 
Define

1

ADD NOTE 

2

COPY

3

DEFINE



HIGHLIGHT TOOL, ZOOM, SYNC

HIGHLIGHT TOOL ZOOM SYNC



ANNOTATE 
YOUR 

DOCUMENT

• Use this field to make notes on the current document. These are not 
located to a specific position, unlike ‘sticky’ notes. You can use rich-text 
formatting to apply bold, italics and underlining for emphasis. Note that 
the contents of ‘General notes’ will also be returned in search results.

GENERAL NOTES

• Each document you open for reading will receive its own tab. You can 
switch back and forth between documents by clicking on each.  Return to 
the browsing view by closing the document tabs, or by clicking on the 
‘My Library’ tab that appears

TABS

• Use this tool to select text within your document. You can use this to 
copy and paste relevant passages, or to apply highlighting

TEXT SELECT TOOL



CITATION 
PLUGIN

∙ It is a free, simple plugin for Microsoft 
Word (Windows, Mac) .

∙ Allows you to quickly and easily insert 
styled citations to reference materials 
from your Mendeley Library.

∙ Automatically generates a bibliography 
for your paper using all the materials 
you’ve cited.

∙ Pick from a huge and growing library of 
citation styles and easily restyle all 
citations in a paper with a few clicks.



INSTALLING THE CITATION PLUGIN

• Ensure your word processor is 
closed before attempting to install 
the plugin.

• Open the Tools Menu and select 
the appropriate option. Mendeley 
will detect which word 
processor(s) you have installed, 
so the options available to you 
may vary.

• The citation tool installs very 
quickly and will confirm once it 
finishes



MENDELEY CITE

• Cite without having Mendeley Desktop open or 
even installed, minimizing potential 
performance loss.  Mendeley Cite opens as a 
separate panel in Word alongside your 
document window, not over it, so your whole 
document remains visible as you find, select and 
insert references. Get the Mendeley Cite at: 
https://www.mendeley.com/reference-
management/mendeley-cite

https://www.mendeley.com/reference-management/mendeley-cite




CITATION 
BUILDING

CHOOSE THE DESIRED 
REFERENCE

DETAILED SEARCH “Go To 
Mendeley”

PRESS THE CITE BUTTON



INSERT 
BIBLIOGRAPHY

Once you’ve done adding citations, you’ll 
need to generate a bibliography. Ensure 
your cursor is positioned where you want 
your bibliography to appear and press 
the ‘Insert Bibliography’ button - it just 
takes one click!

Mendeley will now look through your 
manuscript, pick out all the citations 
you’ve added and order them into a list. 
The exact ordering and appearance of 
your bibliography will depend on the 
citation style - which we’ll talk about next.



Thank You


